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Lesson objectives
 To edit the company chart of accounts

 To add a new customer to the Customers & Jobs list

 To add a new vendor to the Vendor list

 To learn about custom fields, and to practice adding custom fields

 To see how to manage lists in QuickBooks

Supporting materials
 Handout 1: Balance sheet accounts

 Handout 2: Accounts created automatically

 PowerPoint file: Lesson 3

 Video tutorial: Adding and using QuickBooks accounts

 Video tutorial: Introducing the Customer Center

 Video tutorial: Introducing the Vendor Center

Instructor preparation
 Review this lesson, including the examples, to make sure you’re familiar with the 

material.

 Ensure that all students have a copy of qblesson.qbb on their computer’s hard disk.

 Have Handouts 1 and 2 ready for distribution.
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To start this lesson

Before you perform the following steps, make sure you have installed the exercise file 
(qblesson.qbb) on your hard disk. See “Installing the exercise file” in the introduction 
to this guide if you haven’t installed it.

The following steps restore the exercise file to its original state so that the data in the file 
matches what you see on the screen as you proceed through each lesson.

To restore the exercise file (qblesson.qbb):
1 From the File menu in QuickBooks, choose Open or Restore Company.

QuickBooks displays the Open Company: Type window.

2 Select “Restore a backup copy (.QBB) and click Next.

3 In the Restore Backup: Method window, select Local Backup and click Next.

4 In the Open window, navigate to your c:\QBtrain directory.

5 Select the qblesson.qbb file, and then click Open.

6 In the “Restore Backup: To Location” window, click Next.

7 Navigate to your c:\QBtrain directory.

8 In the File name field of the Restore To window, type lesson 3 and then click Save.

9 Click OK when you see the message that the file has been successfully restored.

Using QuickBooks lists

QuickBooks lists organize a wide variety of information, including data on customers, 
vendors, inventory items, and more. Lists save you time by helping you enter 
information consistently and correctly. When you store information on a list, you enter 
it once and never need to retype it. Think about how much information you use more 
than once in your business:

 Names, addresses, and other information about customers who purchase from you 
on a regular basis

 Contact information for vendors from whom you purchase your supplies

 Descriptions and prices for products or services you sell again and again

Simply enter repetitive information into a list once, and then use it over and over on 
checks, on invoice forms, and other daily transactions. You don’t have to enter all the 
information for your company lists before you begin working with QuickBooks. You can 
add information to lists as you go along.
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Editing the chart of accounts

The chart of accounts is your most important list because it shows how much your 
business has, how much it owes, how much money you have coming in, and how much 
you’re spending. When you set up your own company in QuickBooks, the EasyStep 
Interview lets you choose a chart of accounts designed especially for your type of 
business. However, not every business has the same needs; you’ll want to make a few 
changes to the list.

To display the chart of accounts:
1 From the Lists menu, choose Chart of Accounts.

QuickBooks displays the chart of accounts for Rock Castle Construction.

2 Scroll through the list. The chart of accounts displays balance sheet accounts first, 
followed by income and expense accounts.

Refer to Handout 1, “Balance sheet accounts” as you explain each account type and the 
kinds of transactions you use each type for.

QuickStart Tip
Before you modify the preset chart of accounts, we recommend that you have your 
accountant or QuickBooks Professional Advisor review the chart of accounts that 
QuickBooks has set up for you. You may need to add income and expense accounts, add 
subaccounts, delete accounts, or move accounts. It is important to decide on an account 
structure before you begin entering transactions.
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Editing an account

If any of the accounts don’t suit your needs, you can edit or delete them. In the next 
exercise, you’ll edit Rock Castle Construction’s Checking account to provide the 
account number.

To edit an account:
1 In the chart of accounts, select Checking.

2 Click the Account menu button (at the bottom of the window), and then select Edit 
Account.

QuickBooks displays the Edit Account window.

3 In the Description field, type Great Statewide Bank.

Your window should look like this.

4 Click Save & Close.
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Adding subaccounts

The Dues and Subscriptions expense account has one subaccount called Union Dues. 
Rock Castle Construction wants to add a second subaccount for trade publications.

To add a subaccount:
1 In the chart of accounts, click the Account menu button and then choose New.

QuickBooks displays the Add New Account: Choose Account Type window.

2 Select Expense.

3 Click Continue.

4 In the Account Name field, type Trade Pubs.

5 Select the “Subaccount of” checkbox, and then select Dues and Subscriptions in the 
drop-down list.
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6 In the Description field, type Trade Publications.

7 Click Save & Close.

QuickBooks displays the new subaccount in the chart of accounts list.

8 Close the chart of accounts.

Explain to students that in addition to the accounts that QuickBooks sets up by default 
based on the industry they select during the EasyStep Interview, QuickBooks also creates 
certain accounts as needed based on the features used in the program. For a list of these 
accounts, refer to Handout 2, “Accounts created automatically.”
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Working with the Customers & Jobs list

The Customer Center stores names, addresses, and other information about your 
customers. It also holds information about the jobs or projects you may want to track 
for each customer.

Adding new customers

In this exercise, you’ll add a new customer to the Customers & Jobs list.

To add a new customer:
1 Click Customer Center in the icon bar.

QuickBooks displays the Customer Center, which includes the Customers & Jobs 
list.

The Customer Center lets you add, edit, and get reports on your customers. Each 
customer in the list can have multiple jobs (you may call them projects or accounts). 
Notice that this Customers & Jobs list already has quite a few entries.

2 Click the New Customer & Job menu button (at the top of the Customer Center), 
and select New Customer.
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QuickBooks displays the New Customer window.

The New Customer window is where you enter all the information about a new 
customer, including billing and shipping addresses, contacts, credit limit, and 
payment terms. QuickBooks uses the information you enter to complete invoices, 
bills, and receipts. When you’re setting up your company file, you use this window 
to record customers’ opening balances.

3 In the Company Name field on the Address Info tab, type Godwin Manufacturing, and 
then press Tab.

Notice that QuickBooks fills in the Customer Name field and the first line of the Bill 
To field with the information you typed in the Company Name field.

QuickBooks displays the name listed in the Customer Name field in the Customers 
& Jobs list. By default, QuickBooks sorts the list alphabetically. 

Note: If you are entering individual names, you may want to use last name, first name 
in the Customer Name field so that your Customers & Jobs list displays the 
names with the last name first. This is useful for alphabetical sorting of lists and 
reports.

4 In the Bill To field, click at the end of the company name line and press Enter.

5 Type 376 Pine Street, and then press Enter.

Notice that you press Tab to move between fields, but you press Enter to move from 
one line to the next within a field.

6 On the next line of the Bill To field, type Bayside, OR 64326.
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7 Click Copy to have QuickBooks copy the billing address to the Ship To field.

Each of your customers can have multiple shipping addresses. You can also set 
which address to use as the default address. The default address for each customer is 
used on sales forms, letters, labels, and in Shipping Manager.

8 Click OK to use this address as the Godwin Manufacturing ship to address.
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9 Continue filling out the customer information by providing the following 
information:

 Contact: John Godwin

 Phone: 325-555-9841

 Fax: 325-555-0012

 Alt Contact: Tracy Heldt

Note: If you plan to e-mail invoices or statements to customers using the Send Forms 
feature, use this window to enter your customers’ e-mail addresses.
79



W o r k i n g  w i t h  l i s t s
Providing additional customer information

You’ve just completed the Address Info tab for a new customer. The Additional Info tab 
is where you can provide other important information, such as customer type (if you 
want to categorize your customers in some way), payment terms, and sales tax 
information.

To add additional information to a customer record:
1 Click the Additional Info tab.

QuickBooks displays the Additional Info tab of the New Customer window.

2 In the Type field, type Industrial.

The Type field lets you track customers in any way that is meaningful for your 
business. For example, if you run ads on television, radio, and in print, and you want 
to know which advertising method brings you the most customers, you can assign 
customers a “type” (TV, Radio, or Print) and run reports that tell you which referral 
source is most effective. Rock Castle Construction uses the Type field to categorize 
customers by the type of service provided.

3 Press Tab.

QuickBooks tells you that Industrial is not currently on the Customer Type list and 
asks if you wish to add it.
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4 Click the Quick Add button to add the customer type to the list.

Quick Add lets you set up the item with a minimum amount of data. If you click Set 
Up, you can enter more detailed information, but that interrupts the process of 
creating a new customer.

5 In the Terms field, type Net 30.

6 In the Tax Code field, select Non from the drop-down list.

7 In the Tax Item drop-down list, select Out of State.

Your screen should now look like this.
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Providing customer payment information

The Payment Info tab is where you enter customer account numbers and credit limits. 
QuickBooks remembers each customer’s credit limit and warns you when a customer is 
about to exceed it. You can also record information about each customer’s preferred 
payment method. For customers who pay by credit card, you can enter credit card 
numbers and expiration dates.

To add payment and credit information to a customer record:
1 Click the Payment Info tab.

2 In the Credit Limit field, type 2000.

3 In the Preferred Payment Method drop-down list, choose Check.

When you finish, your window should look like this.

4 Click OK to add the customer and close the New Customer window.

QuickBooks displays the Customers & Jobs list with Godwin Manufacturing added 
at the top of the list. You’ll learn how to sort the list later.

5 Close the Customer Center.

QuickStart Tip
QuickBooks has several preset reports related to customers. Some reports you may find 
useful are the sales by customer summary and the sales by customer detail reports (under 
the Sales submenu in the Reports menu).

You may also find the A/R aging summary, A/R aging detail, customer balance summary, 
customer balance detail, and open invoices reports useful. You’ll find them under the Cus-
tomers & Receivables submenu in the Reports menu.
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Working with the Employee Center

The Employee Center stores information about your employees such as name, address, 
and social security number. It also stores information QuickBooks needs to calculate 
your employee paychecks (if you are using QuickBooks for payroll). You’ll learn how to 
enter employee payroll information later in this course. For now, enter only the basic 
employee information.

QuickBooks uses the information you enter in the Employee list to track sales and fill in 
information on checks and other forms.

Adding new employees

Suppose that Rock Castle Construction has hired a new employee and you want to add 
her information to the Employee list.

To add a new employee:
1 Click Employee Center in the icon bar.

QuickBooks displays the Employee Center, including the Employee list.

The Employee Center is where you add a new employee, edit information for an 
existing employee, or delete an employee name (as long as you have not used the 
employee name in any transactions).

2 Click the New Employee at the top of the Employee Center.
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QuickBooks displays the New Employee window.

The Personal tab is where you enter basic information about the employee, such as 
name, Social Security Number, and date of birth.

3 In the First Name field, type Marlene.

4 In the Last Name field, type Duncalf, and then press Tab.

Notice that QuickBooks fills in the “Print on Check as” field with the information 
you entered in the name fields. You can enter a different name if you wish.

5 In the SS No. field, type 123-45-6789.

6 In the Gender field, select Female from the drop-down list.
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7 In the Date of Birth field, type 7/18/82.

The Personal tab should look like this.

8 Click the Address and Contact tab.

9 In the Address field, type 195 Spruce Avenue, #202.

10 For the City, State, and Zip fields, type Bayshore, CA 94326.
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11 In the Phone field, type 415-555-1111.

When you finish, the window should look like this.

12 In the Change tabs field, select Employment Info from the drop-down list.

13 In the Hire Date, type 11/26/2000.

14 Click OK.

15 When QuickBooks asks if you want to set up payroll information, click Leave As Is.

You learn how to set up payroll in Lesson 12.

QuickBooks updates and displays the Employee list with the new employee’s name 
added.

16 Close the Employee Center.
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Working with the Vendor Center

The Vendor Center is where you record information about the companies or people 
from whom you buy goods or services. QuickBooks uses the data in the Vendor Center 
to fill in purchase orders, receipts, bills, and checks as you receive and pay for goods and 
services.

Adding new vendors

In this exercise, you’ll add a new vendor to the Vendor Center. Suppose Rock Castle 
Construction is working with a new subcontractor, and it needs to add information 
about the new vendor to its QuickBooks Vendor list.

To add a new vendor:
1 Click Vendor Center in the icon bar.

QuickBooks displays the Vendor Center.

2 Click the New Vendor menu at the top of the Vendor Center and choose New 
Vendor.

QuickBooks displays the New Vendor window.

The New Vendor window is where you enter all of the information regarding a new 
vendor, such as name, phone, contact, address, and opening balance. Just as when 
you add a new customer, you start by providing basic information on the Address 
Info tab.
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3 In the Vendor Name field, type Hughes Electric.

This is the name QuickBooks displays for this vendor in the Vendor list. If the 
vendor is an individual, you may wish to enter the last name first, then the first 
name.

4 In the Company Name field, type Hughes Electric, and then press Tab.

5 Click in the Name and Address field, after the company name displayed on the first 
line, and press Enter.

Notice that QuickBooks displays the company name on the first line of the Address 
field.

6 On the second line of the Address field, type P.O. Box 2316.

7 Press Enter to move to the next line.

8 Type Middlefield, CA 94432.

9 In the Contact field, type David Hughes.

10 In the Phone field, type 510-555-6666.

11 In the FAX field, type 510-555-6667.

When you finish, your window should look like this.
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Providing additional vendor information

The Additional Info tab in the New Vendor window is where you can enter a vendor type 
(if you want to categorize your vendors), payment terms, your credit limit, the vendor’s 
tax identification number, whether this vendor is eligible for a 1099 form, and your 
opening balance. You’ll add this information now for Hughes Electric.

To add information to a vendor record:
1 Click the Additional Info tab.

QuickBooks displays the Additional Info tab of the New Vendor window.

2 In the Account No. field, type 123-445.

3 In the Type field, type Subcontractors.

Notice that when you type “sub,” QuickBooks fills in the rest of the word.

4 In the Terms field, choose “2% 10 Net 30” from the drop-down list.

5 In the Credit Limit field, type 2000 and press Tab.

Your New Vendor window should resemble the figure below.
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6 Click OK.

QuickBooks adds the vendor and displays the updated Vendor list.

Notice that Hughes Electric has been added to the list.

7 Close the Vendor Center.

QuickStart Tip
QuickBooks has several preset reports related to vendors. Some reports you may find 
useful are the purchases by vendor summary and detail reports (under the Purchases 
submenu in the Reports menu).

You may also find the A/P aging summary, A/P aging detail, unpaid bills, and the vendor 
balance summary reports useful. You’ll find them under the Vendors & Payables 
submenu in the Reports menu.
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Adding custom fields

QuickBooks lets you add custom fields to the Customers & Jobs, Vendor, Employee, and 
Item lists. Custom fields give you a way to track additional information specific to your 
business. For example, you can add a field for pager numbers to your Vendor and 
Employee lists, a field for customers’ birthdays to your Customers & Jobs list, and fields 
for units of measurement, color, and size to your Item list.

When you add the custom fields to your sales forms or purchase orders, the fields are 
prefilled with the information for that specific customer, employee, vendor, or item (if 
you specified a value for the custom field when you added the customer, for example). 
You don’t have to add the custom fields to your forms, however; you can also use custom 
fields as a way to record information just for your use, such as a credit rating for each 
customer. QuickBooks remembers the information you entered in the custom fields 
when you import and export data and when you memorize transactions.

You can add up to seven custom fields to each Customers list, Vendors list, or Employees 
list. Overlapping fields count as one field on each list. For example, if you add a custom 
“Birthday” field for customers and vendors, you can still add six additional fields to each 
list.For each of the names lists (customer, vendor, and employee), you can add up to 
seven custom fields, including fields that are on more than one list. You can add up to 
five custom fields for the Item list. (Custom fields for the Item list are tracked separately 
from custom fields for the customer, vendor, and employee lists.)

After you add custom fields, you can use them on invoices, credit memos, sales receipts, 
purchase orders, estimates, and sales orders (QuickBooks Premier and higher only).

Adding custom fields for customers, vendors, and employees

You can enter information in the custom fields only through the New or Edit windows 
(for example, the New Customer or Edit Customer windows). You can display 
information from the custom fields on forms as well as add custom fields to reports.

First, look at the custom fields that Rock Castle Construction has already added to its 
Customers & Jobs, Vendor, and Employee lists. Then, you’ll add two new custom fields.

To add custom fields:
1 Click Customer Center in the icon bar.

QuickBooks displays the Customer Center.

2 In the Customers & Jobs list, select Cook, Brian.
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3 Click the Edit Customer button.

QuickBooks displays the Edit Customer window.

4 Click the Additional Info tab.

QuickBooks displays the Additional Info tab in the Edit Customer window.
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5 Click Define Fields.

QuickBooks displays the Set up Custom Fields for Names window.

Notice that Rock Castle Construction has already set up custom fields in the 
Customers & Jobs list for contract number, birthday, and spouse’s name. In the 
Vendor list, they have set up a custom field for discount available. In the Employee 
list, they have set up custom fields for the date of last raise and spouse’s name.

Now, you’ll add a custom field for pager numbers to the Customers & Jobs and 
Vendor lists. You’ll also add a custom field to the Employee list that tracks the date 
of each employee’s last review.

6 Click below Spouse’s name in the Label column and type Pager Number.

7 Click the Cust column.

8 Click the Vend column.

9 In the next line of the Label column, type Date of last review.
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10 Click the Emp column.

Your Define Fields window should now look like this.

11 Click OK.

12 If you see an informational message about using the custom fields in transactions by 
turning them on in your custom templates, click OK.

QuickBooks has added the Pager Number field to the Edit Customer window.
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13 In the Pager Number field, type 415-555-9876.

If you customize your sales forms to display the Pager Number field, this number 
displays whenever you create a form for this customer. It also displays on reports 
modified to display the Pager Number column.

14 Click OK to close the Edit Customer window.

15 Close the Customer Center.

Adding custom fields for items

Now suppose that Rock Castle Construction wants to add another custom field to its 
Item list. The company purchases several types of locking doorknobs. The Item list 
already has custom fields for Color and Material, but now Rock Castle wants to add an 
additional field to track Style.

To add custom fields for items:
1 From the Lists menu, choose Item List.

QuickBooks displays the Item list, as shown below.

2 In the Item list, select Lk Doorknobs (a sub item of Hardware).
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3 Click the Item menu button, and then choose Edit Item.

QuickBooks displays the Edit Item window.

Note: Notice the Manufacturer’s Part Number field. This part number is a unique 
number or code assigned by the manufacturer to each of their items. Since 
purchase orders are usually sent to the manufacturer, using the 
manufacturer’s part number will ensure that your vendor knows exactly 
what is being ordered.

4 Click Custom Fields.

QuickBooks displays the custom fields already defined for this item.

5 Click Define Fields.

QuickBooks displays the Set up Custom Fields for Items window.

6 Click the Label field below Material and type Style, then click the Use column.
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7 Click OK to close the window.

If you see an informational message about using the custom fields in transactions by 
turning them on in your custom templates, click OK.

8 In the “Custom Fields for Lk Doorknobs” window, type Round in the Style field.

9 Click OK to close the Custom Fields for Lk Doorknobs window, and then click OK to 
close the Edit Item window.

10 Close the Item list.

Managing lists

Lists are easy to manage in QuickBooks. You can sort lists, combine (merge) list items, 
rename list items, delete list items, make list items inactive, and print lists.

Sorting lists

You can sort many QuickBooks lists manually or alphabetically. To sort a list manually, 
simply use the mouse to drag a list item to its new location. Lists that you can sort this 
way are the Chart of Accounts, Customers & Jobs, Class, Customer Type, Vendor Type, 
Job Type, and Memorized Transaction lists.

If you have changed the order of a list by dragging items and then decide you’d rather 
have an alphabetically sorted list, QuickBooks has a Re-sort List command. In the chart 
of accounts, the Re-sort List command sorts alphabetically within account type; in the 
Item list, the Re-sort List command sorts alphabetically within item type.

QuickStart Tip
You can add custom fields you’ve set up for customers or items to any sales form. 
Similarly, you can add customer fields you’ve set up for vendors or items to the purchase 
order form. If you want to filter a report based on text in custom fields, you must add the 
fields to the form used to generate the report. For example, if you want to filter the open 
purchase orders report by style, you need to add the Style field to the purchase order 
template you use.
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Sorting lists manually

In this exercise, you’ll sort a list manually, and then re-sort it to put it back in 
alphabetical order.

To sort a list manually:
1 From the Lists menu, choose Chart of Accounts.

QuickBooks displays the chart of accounts for Rock Castle Construction.

2 Click the diamond to the left of the Owner’s Draw subaccount of Owner’s Equity. 
(You may need to scroll or resize the window to see it.)

3 Click and hold the left mouse button, and drag the pointer upward until you see a 
dotted line directly below Owner’s Equity.

4 Release the left mouse button to drop the account in the new position.

The Owner’s Draw account is now directly under the Owner’s Equity account.

Now you can use the Re-sort List command to return the list to alphabetical order.

5 To re-sort the list alphabetically, click the Account menu button, and select 
Re-sort List.

QuickBooks asks you to confirm that you want to return the list to its original order.

6 Click OK.

QuickBooks re-sorts the chart of accounts alphabetically by account type.

7 Close the chart of accounts.
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Sorting lists in ascending or descending order

Depending on the type of business you have, you may want to order your list entries in 
a certain way. For example, perhaps you’d like to see people who owe you money at the 
top of your Customers & Jobs list. In this exercise, you’ll learn how to sort the Customers 
& Jobs list in descending order by customer balance.

To sort a list in descending order:
1 Click Customer Center on the icon bar to display the Customer Center and 

Customers & Jobs List.

Click this button to expand (or collapse) the 
Customers & Jobs list.
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2 Click the arrow to the right of the View drop-down list to expand the Customers & 
Jobs list.

The Customers & Jobs list now shows details about the customers and jobs.

3 Click the Balance Total column heading.

Notice that an arrow pointing up appears on the heading and the list is sorted in 
ascending order by customer balance.

4 Click the column heading again.
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Notice that the arrow now points down and the list is sorted in descending order 
with the customers with the highest balances at the top of the list.

5 To return to the order you started with, click the large diamond to the left of the 
Name column heading.

6 Click the Collapse arrow to collapse the Customers & Jobs list.

If you don’t collapse the Customers & Jobs list, the next time you open the 
Customer Center, the center opens with the expanded Customers & Jobs list.

7 Close the Customer Center.

Merging list items

In most lists, you can combine two list items into one. For example, you may find that 
you’ve been using two customers (because of different spellings) when you really need 
only one on your Customers & Jobs list. You can merge list items in the Chart of 
Accounts, Item, Customers & Jobs, Vendor, Employee, and Other Names lists.

Note: After you merge list items, you cannot separate them. When working in your 
own company file, we recommend that you back up your data before merging 
list items.

In this exercise, suppose you want to merge Hughes Electric (the vendor you added 
earlier in the lesson) with C.U. Electric. To merge them, you edit the incorrect name to 
match the spelling of the correct name.
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To merge items on a list:
1 From the Vendors menu, choose Vendor Center.

QuickBooks displays the Vendor Center.

2 Double-click the entry for Hughes Electric.

QuickBooks displays the Edit Vendor window.

3 In the Vendor Name field, type C.U. Electric. (This is the vendor name you want to 
merge with.)

4 Click OK.

QuickBooks asks if you would like to merge the names.

5 Click Yes.

QuickBooks merges the two names, and you now have only C.U. Electric in the 
Vendor list.

6 Close the Vendor Center.

Note: You cannot merge items on the Fixed Asset Item list. In addition, if you use 
assembly items in QuickBooks Premier Edition products, you cannot merge 
them with other assembly items or with any other type of item.
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Renaming list items

You can rename any list item. When you make the change, QuickBooks automatically 
modifies all existing transactions containing the item.

Note: If you don’t want to change existing transactions, add a new name or item 
instead.

To rename a list item in the chart of accounts:
1 From the Lists menu, choose Chart of Accounts to display the chart of accounts for 

Rock Castle Construction.

2 In the chart of accounts, select Checking.

3 Click the Account menu button, and choose Edit Account.

QuickBooks displays the Edit Account window.

4 In the Account Name field, type Master Checking Account.

5 Click Save & Close.
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QuickBooks changes the account name in the chart of accounts.

6 Close the chart of accounts.

Deleting items and making list items inactive

You can delete list items only if you have not used them in any transactions. If you try 
to delete a list item that is used in a transaction, QuickBooks displays a warning that the 
item can’t be deleted. If you don’t want to use a list item but you can’t delete it, you can 
make it inactive.

To make a list item inactive:
1 On the Home page, click the Customers button (along the left side of the Home 

page).

QuickBooks displays the Customers Center, including the Customers & Jobs list.

2 Select Milner, Eloyse in the list. (Select her name, not the job.)

3 Right-click the name and choose Make Customer:Job Inactive. (You can also click 
Edit Customer and then select the “Customer is inactive” checkbox.)
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Notice that Eloyse Milner (and the job for her room addition) no longer appears on 
the Customers & Jobs list. (The customer and job item is only removed from the 
list—transactions associated with this customer and job will still show in reports.)
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4 To see inactive list items, choose “All Customers” from the View drop-down list.

QuickBooks displays all the list items again, but the Xs signify that this customer is 
still inactive. (You make the customer active again by right-clicking the name and 
choosing Make Customer:Job Active.)

5 Leave the Customer Center open to use in the next exercise.
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Printing a list

You can print a QuickBooks list for reference, or you may print a list to a file to use in 
your word processor or spreadsheet. QuickBooks prints the Customers & Jobs list as it 
appears on the screen. For example, if the Customers & Jobs list is expanded and sorted 
by balance total, QuickBooks prints the expanded list sorted by balance total; if the list 
is collapsed, QuickBooks prints just the customer name, the balance total, and active 
status.

To print the Customers & Jobs list:
1 In the Customer Center, click the Print menu button, and then choose Customer & 

Job List.

QuickBooks displays a message telling you that you can also print list information 
from the Reports menu.

2 Click OK to close the List Reports message.

QuickBooks displays the Print Reports window, which displays the name of your 
printer and printer port.

You can select to print to a printer or to a file.

3 Click Print.

Note: This is a fairly long list, so if you don’t want to print it now, click Cancel.

To print information on one customer:
1 In the Customers & Jobs list, select the customer whose details you want to print.

2 Click the Print menu button, and then choose Customer & Job Information.

QuickBooks displays the Print Customer Information window, which displays the 
name of your printer and printer port.

You can select to print to a printer or to a file.

3 Click Print or Cancel.

If you want to print information for selected customers only, you can generate and filter 
the Customer Contact report for those customers. You can also modify the report to 
include the columns that you want.
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To print information for selected customers:
1 From the Reports menu, choose List, and then choose Customer Contact List from 

the submenu.

2 Click Modify Report.

3 Click the Filters tab.

4 Select Customer in the Filter list.

5 In the Customer field, choose Multiple customers/jobs.

6 Make sure Manual is selected and then click to put a checkmark next to those 
customers for which you want to print contact information.

7 Click OK to close the Select Customer:Job window.

8 Click OK to close the Modify Report window.

9 Print the report.

10 Close the report window. Click No if you are asked whether you want to memorize 
the changed report.

11 Close the Customer Center.

Let students know that if they want to print the list to a file (so they can use it in their 
word processing, spreadsheet, or database program), they can select File and choose the 
appropriate file format from the drop-down list.

QuickStart Tip
QuickBooks has preset reports that let you report on the information in your 
QuickBooks lists. For example, you can create a phone list and a contact list for your 
customers, employees, and vendors. You can also create a price list for the items stored on 
your QuickBooks Item list.

To create a list report, from the Reports menu, choose List, and then choose the list report 
you want to generate.
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Adding or editing multiple items at one time

If you have existing information in Microsoft Excel that you want to add to QuickBooks, 
or if you want to make changes to multiple items, you can do so for items in the 
following lists: Customers, Vendors, Service Items, and Non-inventory Parts.

In this exercise, you will change the zip code for East Bayshore for all your customers and 
vendors in that city.

To change the zip code for multiple items:
1 Go to the Lists menu and choose Add/Edit Multiple List Entries.

2 Make sure that Customers is selected for the List drop-down.

3 For the View drop-down, select All Customers.
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4 In the Find field, type East Bayshore.

5 Click the magnifying glass icon.

6 Use the slider bar at the bottom of the screen to view the Bill To 3 field.

7 Click in the first line to select 94327 and change it to 94329.

8 Repeat to change every item in the list.

9 Click Save Changes.

10 In the List drop-down, select Vendors.

11 In the View drop-down, select All Vendors.
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12 Type East Bayshore in the Find field and click the magnifying glass icon.

13 Since none of the vendors use the 94327 zip code, click Close without making any 
changes.
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